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Prelude

Terima kasih atas kepercayaan Anda telah memilih VPSTrading.net sebagai business server

partner. Kami ingin memastikan Anda bisa menggunakan seluruh fitur server yang kami berikan

untuk kemajuan bisnis Anda.

Jadi, bersiaplah untuk mengikuti panduan ini, pastikan telah menerima kredensial server, karena

panduan ini akan membantu Anda mulai dari awal sekali.

Jika masih belum memiliki layanan kami, ikuti petunjuk dari support/partner/afiliasi kami

untuk mendapatkan layanan & dukungan penuh kami.
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Automate System?

Adalah fitur UTAMA yang ada di server trading kami. Sistem ini memiliki konfigurasi aktif yang

sudah ada secara default, dan ada bagian yang perlu Anda aktifkan. Jangan khawatir, meskipun

Anda pemula, proses yang perlu Anda lakukan sangat mudah.
—-

1. Remote Server

Pertama, lakukan remote ke server Anda menggunakan kredensial yang telah Anda dapatkan.

Search program di Windows: Remote Desktop Connection.
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Saat program terbuka, terlihat seperti gambar di bawah ini, klik tombol Show Options

Muncul tampilkan Remote Desktop Connection lebih lengkap untuk mengkonfigurasi program

remote Anda, seperti di bawah ini:
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Computer: Masukan IP Address Server

User name: Masukan Username Anda

Checked Allow me to save credentials

Lalu, klik Save As untuk menyimpan (RDP

file) konfigurasi remote tersebut.

Gunakan RDP file tersebut untuk mengakses

server Anda kembali.

Klik tombol Connect, untuk mulai remote

server Anda.
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Saat terkoneksi, Anda akan diminta memasukan password default yang Anda terima dari kami

melalui email. Masukan password tersebut di jendela Enter your credentials.

Lalu ikuti instruksi pergantian password terlebih dahulu sebelum masuk ke dalam server Anda.

Klik OK untuk mengikuti instruksi pergantian password.
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Strength Password Required

Gunakan minimal 10 karakter, mengandung

huruf kecil, besar & karakter spesial. SIMPAN

PASSWORD ANDA DENGAN AMAN.

Password : Masukan password default.

New password : Masukan password baru.

Confirm password : Masukan password

baru sekali lagi.

Tekan tombol Enter atau klik tanda panah.
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Perhatikan tampilkan server di atas, soroti menu-menu di dalam server yang kami beri tanda

Box Hijau. Anda akan mulai bekerja di menu-menu tersebut.
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—-

2. Using as Trading Server

Setelah berhasil mengakses server pertama kali, sistem otomatis mengaktifkan fitur-fitur krusial

untuk kegiatan trading. Mari kami pandu langkah pertama untuk menggunakan server trading

kami.

Sekarang, fokus pada menu-menu yang kami sebutkan sebelumnya. Buka folder ‘MENU’, Anda

akan mendapatkan isi MENU sebagai berikut:
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Ada beberapa menu yang Anda lihat, semua bisa Anda pelajari di waktu luang Anda. Sekarang,

kami arahkan Anda untuk menyoroti folder AUTOMATE ACTIVATION. Anda buka folder

tersebut.

Terdapat 4 Menu yang sudah kami urutkan untuk mempermudah Anda memulainya.
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1. Webhook API Notification

Ini adalah alat bantu yang mengintegrasikan semua, webhook akan memberikan interaksi server

berupa pesan kepada Anda melalui Email/Whatsapp/Telegram Anda.

Webhook ini adalah sebuah URL unik & khusus setiap pelanggan.

Format Webhook: https://api.vpstrading.net/your-id-webhook.

Apabila Anda mengambil Addon Webhook API saat order, buka folderWebhook API

Notification, Anda akan mendapatkan file setup_webhook_api_url_here.txt

Buka file .txt tersebut dan copy-paste dengan lengkap Webhook API url yang Anda miliki.
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Isi file setup_webhook_api_url_here.txt akan menjadi seperti di atas.

Tekan Ctrl + S atau klik File > Save untuk menyimpan Webhook Anda.

✅ SETTING WEBHOOK DONE

Anda boleh skip setting Webhook apabila Anda tidak mengambil addon Webhook Notification.
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2. WinAutoLogin Activation

Aktivasi ini bertujuan agar server memiliki akses otomatis menjalankan MetaTrader pada proses

startup. Ini adalah jalan cepat untuk menghidupkan kembali MetaTrader Anda tanpa repot-repot

re-login dan menghidupkan program satu per satu.

Buka folderWinAutoLogin Activation dan jalankan program

WinAutoLoginActivation.exe.

Jika password sudah memenuhi standard di dalam gambar di atas, Anda bisa jawab dengan

ketik ‘N’.
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Jika password masih lemah, memiliki urutan yang mudah ditebak, kami sangat

merekomendasikan ikuti aktivasi WinAutoLogin ini dengan mengganti password terlebih dahulu,

jawab dengan ketik ‘Y’ untuk mengikuti jendela mengganti password terlebih dahulu.

Kami asumsikan Anda tidak mengganti password lagi, karena sudah mengganti password yang

kuat pada awal remote.

Ketik ‘N’ lalu tekan Enter. Lalu, ikuti petunjuk selanjutnya:

Enter the administrator username: masukan username server, lalu tekan Enter

Enter the password: masukan password server, lalu tekan Enter

Verifying password...

Enter the password for username: masukan password sekali lagi, lalu tekan Enter

15



Jika berhasil melakukan verifikasi akan muncul jendela Next step seperti di bawah ini:

Tekan ‘Y’ untuk memproses aktivasi.

The operation completed successfully.

Aktivasi WinAutoLogin berhasil.

Terima kasih telah menggunakan layanan VPSTrading.net

Jika muncul informasi seperti di atas, aktivasi Anda telah berhasil.

✅ WINAUTOLOGIN ACTIVATION DONE

16



www.vpstrading.net

3. MetaGuard

MetaGuard adalah tool yang dikembangkan menggunakan bahasa Meta Language (MQL) untuk

membantu monitoring dan re-connecting live account trading apabila terjadi kendala.

Tahukah Anda? Berbagai potensi kendala seperti chart freeze, diskonek login, server broker

bermasalah, dsb bisa membuat akun live trading Anda mengalami diskonek.

Saat diskonek, seluruh kegiatan trading beserta robot Anda terhenti total. Dengan MetaGuard,

kondisi ini akan termonitor.

Tindakan pertama, MetaGuard akan melakukan re-connecting ke server broker Anda dan

memastikan akun berhasil login.

Berikut ini pesan Whatsapp tindakan pertama saat melakukan re-connecting:
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Tindakan kedua, MetaGuard mengirimkan alert atau pesan Email/Whatsapp/Telegram. Ini akan

membantu Anda mengetahui keadaan server secara realtime bahkan hingga level program

MetaTrader yang berjalan.

Berikut ini pesan tindakan kedua saat reconnecting berhasil:

Mulai menggunakan MetaGuard…

1. Langkah mudah download & install MetaGuard

Buka folderMetaguard dan jalankan program metaguard.exe. Aplikasi ini akan melakukan

instalasi file MetaGuard.ex4 ke seluruh pre-installed MetaTrader 4 yang ada di server Anda.
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Instalasi Anda berhasil jika muncul informasi: SELAMAT, INSTALASI METAGUARD.EX4

BERHASIL.

Cara menjalankan MetaGuard.ex4 ada dalam pembahasan section 3 di bawah.

✅ METAGUARD INSTALLATION DONE

4. LogMan

Folder terakhir di dalam AUTOMATE ACTIVATION, yaitu LogMan.

LogMan adalah fitur performance monitoring yang secara periodik akan memonitor utilitas server

trading Anda. LogMan bekerjasama dengan Webhook API Notification untuk mengirimkan

peringatan overload melalui email/whatsapp/telegram Anda. Fitur ini sangat powerful.
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By default, sistem LogMan telah diaktifkan di server trading Anda. Folder ini berguna apabila

dalam case tertentu Anda perlu mematikan service LogMan atau menjalankan kembali.

Tersedia tombol STOP & START Logman.

Berikut ini pesan CPU overload:
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Berikut ini pesan Memory overload:

—-

3. Running your Expert

Ini adalah langkah ke-3 cara menggunakan server kami. Setelah melakukan aktivasi Automate

(Section 2), sekarang Anda masuk ke bagian inti dalam menggunakan MetaTrader di server

kami.

Perhatikan kembali menu-menu yang ditampilkan di desktop server, terdapat folder

Pre-installed Metatrader. Folder ini berisi folder MetaTrader 4 dan MetaTrader 5

pre-installed.
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Apa fungsi pre-installed MetaTrader ini?

Pre-installed sudah kami siapkan, Anda tidak perlu repot-repot install program MetaTrader

sendiri.

Apa kelebihan pre-installed?

Pre-installed adalah program MetaTrader basic, yang biasa Anda gunakan. Agar MetaTrader

lebih mudah di backup dan tidak perlu menggunakan sistem instalasi Windows, kami

menerapkan versi Portable pada seluruh pre-installed yang ada di server.

Riset lab engineer kami menunjukan, versi portable dari MetaTrader ini berjalan lebih ringan dan

powerful dibandingkan versi normal instalasi, dan tidak mengurangi fungsi dari MetaTrader

sendiri.

Kelebihan lainnya, kami mengembangkan sistem Cross-Connect di dalam server. Sistem ini

mengisolasi setiap pemakaian MetaTrader portable kami menjadi single threading processing.

Hasilnya pemakaian pre-installed lebih hemat resource CPU.
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1️⃣ Running Experts OnMetaTrader 4 + MetaGuard

Apabila Anda menggunakan MT 4, jalankan dahulu MetaTrader 4 pre-installed dan login ke

server broker Anda.

Scan Server Broker (MetaTrader 4 Menu File > Open an Account):

1. Ketikan nama server broker yang digunakan. Pastikan Anda mendapatkan nama server

sesuai dengan entitas broker. Misal: FBS Markets

Sebelum melakukan scan server:
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Setelah scan dengan kata kunci FBS Markets

2. Jika sudah mendapatkan nama server (nomer server) dan kolom Ping menampilkan

milisecond (ms). Anda Klik pada server tersebut dan klik tombol Next, selanjutnya isi Login &

Password akun trading, lalu klik tombol Finish.
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Setelah berhasil login dan sebelum mengaktifkan EA Anda, jalankan dahulu MetaGuard.ex4,

berikut ini petunjuk menjalankan MetaGuard.ex4:
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1. Jadikan akun trading sebagai akun favorites, dengan langkah klik kanan pada akun trading,

lalu pilih tombol Add to favorites. Seperti gambar di bawah ini:

2. Masuk ke MetaTrader 4 menu, Tools > Options, dan pilih tab menu Expert Advisors,

lakukan setting berikut:
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1. Centang Allow automated trading

2. Uncek semua:

- Disable automated trading when the account has been changed.

- Disable automated trading when the profile has been changed.

- Disable automated trading when the chart's symbol or period has been changed.

3. Centang Allow DLL imports.

4. Centang Allow WebRequest for listed URL, dan masukan Webhook Notification

URL Anda (domain atau subdomain tergantung dari url yang Anda dapatkan).
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3. Attach-kan MetaGuard.ex4 ke salah satu chart saja & timeframe 1 Minute.

Misalkan EURUSD Timeframe M1 (1 Minute). Lalu masuk ke tab Inputs configuration.

4. Pada Inputs configuration dari MetaGuard, fokus pada poin konfigurasi berikut ini:

AccountRow: 1 (Use this default).

Delay in Minutes: 5 (Recommended, delay MetaGuard melakukan update monitoring).

Webhook Notification Url: input url Webhook API yang Anda dapatkan.

Your server IP Address for notification: input ip address server.

Offset your time to server time: input selisih timezone Anda dan timezone broker.

Klik OK jika sudah.
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MetaGuard akan menampilkan status di chart Anda sebagai berikut:

MetaGuard juga akan mengirimkan pesan ke email/whatsapp/telegram yang Anda gunakan:

Congratulations, MetaGuard is running in your terminal.
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Akun yang monitor adalah akun yang mengaktifkan MetaGuard. Jadi, apabila Anda menjalankan

banyak akun, sebaiknya jalankan MetaGuard di seluruh akun trading agar seluruh akun trading

Anda termonitor.

Setelah MetaGuard aktif, langkah Anda selanjutnya adalah jalankan EA Anda seperti biasa.

MetaGuard akan berjalan dengan tugas memonitor status akun trading dan tidak memiliki

kemampuan untuk trading. Sehingga Anda bisa menjalankan EA lainnya pada akun yang

menjalankan MetaGuard tanpa masalah.

2️⃣ Running Experts On MetaTrader 5

Apabila Anda menggunakan MT 5, jalankan pre-installed MetaTrader 5 sesuai dengan kebutuhan

Anda.

1. Lakukan scan broker. Petunjuk scan server broker sama dengan MetaTrader 4.

2. Login akun trading dengan server yang sesuai.

3. Jalankan expert Anda seperti yang biasa Anda lakukan.
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3️⃣ Running MetaTrader On StartupWindows

Bagian ini, memandu Anda agar seluruh MetaTrader baik MT4 dan MT5 yang sedang dijalankan

memiliki kemampuan auto open pada saat startup Windows. Kemampuan ini sangat penting &

bermanfaat jika terjadi force majeur atau hal yang tidak diharapkan atau sekedar melakukan

reboot server. Seluruh terminal MetaTrader bisa terbuka secara otomatis, sehingga kegiatan

trading bisa recovery dengan cepat.

Bagaimana caranya?

Kami telah menyediakan menu Startup di desktop server Anda. Secara default folder ini masih

kosong. Yang perlu Anda lakukan HANYA copy shortcut Pre-Installed yang ada di folder

Pre-Installed MetaTrader dan paste di dalam folder Startup ini.
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Tandai MetaTrader yang telah digunakan dengan nama yang jelas, seperti berikut ini:

Contoh di atas, terdapat 4 MetaTrader yang berjalan, kami copy-paste ke-4 shortcut tersebut di

Folder Startup agar empat MetaTrader tersebut bisa memiliki kemampuan auto open.
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Berikut file yang sudah di copy di folder Startup:

MUDAH SEKALI, BUKAN?

Apakah semua program pre-installed di copy-paste ke Startup?

TIDAK, TENTU TIDAK SEMUANYA.

Cukup yang Anda jalankan saja yang perlu memiliki kemampuan Auto Open ini.

Dengan langkah-langkah di atas, Anda sudah menjalankan trading bisnis menggunakan EA pada

server dengan kemampuan Automate System yang kami miliki.
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4. Server Monitoring & Logs

Pada server Automate, setiap kejadian penting yang terjadi di dalam server bisa Anda monitor

melalui menuMONITORING & LOGS. Kami menyediakan beberapa file log yang bisa Anda

gunakan untuk melakukan monitoring dan analisa server untuk keperluan maintenance maupun

keamanan, berikut ini support logs yang tersedia.

1. Task Manager Monitoring

Gunakan Task Manager untuk memonitor pemakaian CPU dan Memory server secara realtime.

2. CPU Overload Logs

CPU Overload logs bisa digunakan untuk meneliti dan melakukan analisa, kapan server

mengalami overload. Seberapa sering dan hingga berapa persen. Ini akan membantu

memutuskan apabila perlu melakukan upgrade paket atau tidak.
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Server yang mengaktifkan fungsi Webhook Notification akan menerima alert Overload CPU:

3. Memory Overload Logs

File ini sama dengan CPU logs di atas. Khusus untuk logs memory overload.

Server yang mengaktifkan fungsi Webhook Notification akan menerima alert Overload Memory:

4. Login Logs

Setiap login yang dilakukan melalui Remote Desktop, akan terecord di file log ini. Anda bisa

analisa lebih lanjut apabila diperlukan untuk alasan keamanan.

Server yang mengaktifkan fungsi Webhook Notification akan mendeteksi aktifitas login melalui

Remote Desktop dan memberikan alert:
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5. Reboot Logs

Reboot log akan mendeteksi kapan terakhir server di-reboot atau mengalami reboot yang

disebabkan oleh provider. Log akan menampilkan user yang melakukan reboot. Ini bisa menjadi

analisis lanjutan untuk menjaga keamanan server.
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Thank you

Semoga berguna dan membantu kesuksesan Anda.

Selain panduan utama di atas, server kami juga dilengkapi ADDON, TOOLS, TRADE UTILITIES

lain pendukung bisnis trading. Untuk mempelajarinya ikuti journal informasi kami dengan cara

follow media berikut ini:

https://t.me/vpstradingnews

Simpan kontak kami support@vpstrading.net di daftar kontak gmail atau provider email yang Anda

gunakan. Agar Anda tidak tertinggal update penting yang kami release.

Want to buy me a coffee☕ ?

😉
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